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secrets reve  

There’s a great deal more to the latest version of the Mac OS X than stylish toolbars and interface
gimmicks. Rob Buckley reveals the hidden depths that make Panther the world’s most powerful and
cutting-edge Operating System...
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P
anther is pretty good now, isn’t it? Looking at its
now-ancient predecessor, OS 9, and even at
previous versions of OS X, it’s obvious to anybody
who hasn’t had a chip implanted in their brain by

Microsoft that Panther (aka OS X 10.3) is by far the best
Operating System there’s ever been. It’s the nicest to look
at, nicest to use and has a feature set so thick you could
break down walls with it.

As if being able to use just about any common modern
peripheral or digital camera without even having to install
some software wasn’t enough, the ways in which Panther
can do simple things as easily as it can do tough jobs like
printing to a password-protected printer connected to a
Windows PC are enough to take your breath away – kind of. 

Panther keeps a lot of its juiciest features hidden
underneath the covers, but keep reading and you’ll learn all
about Panther’s secrets. How to do what only the most
knowledgeable Mac users can do and even how to use
features that Apple deliberately hid from us! So join us, as we
uncover the hidden depths of this remarkable OS that are
guaranteed to make Windows users green with envy. 
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Burn multi-session discs
There’s nothing more annoying
than having to use only a small

fraction of a CD’s capacity. Fortunately,
Panther’s Disk Utility lets you keep on filling
up the CD even after you’ve written to it.
Instead of burning directly from the Finder,
create a folder of your files then use Disk
Utility’s ‘New image from folder…’
command to create a disk image from it.
You can then burn that image by picking it
from the sidebar of Disk Utility and clicking
‘Burn’. You can burn this image to a blank
CD-R as well as to one you’ve done this to
before as long as you have space.

Make friends with
Menulets
Menulets are little icons that sit

in your menu bar and let you change your
iChat status, run iSync, monitor your AirPort
connection or battery status and other
useful little tricks. Whenever you’re in an
application, look in its preferences to see if
there’s an option to ‘Display status in menu
bar’. If there is, the menulet it creates
might be a handy timesaver that stops you
having to crank up an application, AirPort
Assistant or the system preferences every
time you want to do something.

Desktop picture
slideshows
Don’t like your current desktop

background, but can’t decide which image
to replace it with? The Desktop & Screen
Saver System Preference pane lets you
alternate your background at regular
intervals – from every five minutes to every
day. Simply drag a folder of pictures to it or
pick a folder using ‘Choose Folder…’ and
decide how often you want change in your
desktop’s life. Best of all, if you have iPhoto
4, you’ll have instant access to your photo
albums as possible backgrounds folders. 

Fast user switching
One of the great things about
OS X is that it’s multi-user: lots

of people can access a Mac and have their
own settings, desktop and private data. But
until Panther, if anyone wanted to get
access to use the Mac, they had to log
anyone else out then log themselves in – a
pain for you and everyone else if you only
wanted to check your emails briefly.
Panther’s Fast User Switching, enabled using
the ‘Login Options’ button of the Accounts
System Preference pane, lets you switch
between accounts in an instant, returning
all your programs and windows to the way
they were before you last switched.

Turn a digicam into a
spycam with Image
Capture

The Image Capture application may be
overshadowed by iPhoto, but it still has
some tricks that are all its own. Plug a
suitable digital camera or Webcam into
your Mac, start up Image Capture and
you’ll be able to share its view over the
Web with anyone who has access to a
web browser. You can use it to monitor an
area and even take pictures of people
who pass by. Open Image Captures
Preferences dialog and click on the
Sharing tab to get started.

Get to grips with
Terminal
For raw, undiluted UNIX power,

nothing beats Terminal. Just about
everything you can do with a mouse, you
can do with Terminal (if you can remember

the command) and then some. You can
also log in to a Mac over a network and
send commands to it, which is useful if
someone else is using it at the time or it
has no working monitor. Importantly, you
can use Terminal to take advantage of the
decades of development of UNIX software
by downloading, compiling and running
any of the countless programs available on
the Web. Find Terminal inside the ‘Utilities’
folder of your ‘Applications’ folder.

Clear clutter with Exposé
Fed up of hunting for one
window among many? Or do

you want to get to the desktop without
having to close or hide all the windows in
front of it? Then Exposé is for you. Using
your mouse or keyboard, you can cause

windows to shrink in size so you can
instantly pick the one you’re after. You can
even make them all move out the way so
you can get to your desktop in a second.
It’s easy to set up using the Exposé System
Preference pane and will save you hours.

Share files with Bluetooth
If your friends have Macs or
even PCs equipped with

Bluetooth, you can easily share files with
them without having to set up a network.
The Bluetooth File Exchange program in
your Utilities folder will allow you to upload
files to another Bluetooth device and also
to browse another device – be it PDA,
mobile phone, PC or Mac – and download
files from it. It’s not as fast as a regular
network or even USB, but if you haven’t
got cables or AirPort, it’s a useful stopgap.

Wireless printing with
Bluetooth
As of Panther 10.3.2, anyone

with a Bluetooth-equipped Mac can print to
a similarly-equipped printer (or at least one
with the right kind of drivers). While there
aren’t too many of these at the moment,
business laptop users who take their
briefcase-sized Bluetooth printer with them
on foreign trips are now able to search for
Bluetooth printers from any of their Macs’
print dialogue boxes as easily as they
would for a network printer.

Conversion with the
Calculator
The Calculator application is

more than just a way to add up your bills: it
also includes some useful conversion tools.
Along with the more scientifically handy
volume, area and energy conversions,
Calculator can also convert distances
between metric and imperial, temperatures
between ºC and ºF and, even more handily,
look up exchange rates on the Internet so
you can convert dollars to pounds and
realise just how much cheaper an iPod is in
the US than the UK. Click on the ‘Convert’
menu to get started.
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The Services menu
Concealed in the
application menu,

‘Services’ are functions that one
application can give to another. With
services, you can highlight some text
in TextEdit, for instance, and have it
open in Safari, read out by the Finder
or sent as a mail message in Mail.
Not all applications offer services or
can use them, but any Services-
aware application can automatically
spot the functions offered by another
services-enabled application as long
as it’s sitting in the Applications folder
or a sub-folder.

Power Tips

You need never be bamboozled by Celsius and
Joules again with the Calculator app’s handy
conversion feature at your disposal

Make your desktop picture change at regular or
irregular intervals by selecting a folder of images as
a desktop picture slideshow

Move between different user accounts in a jiffy with Fast User Switching’s cool cube transition
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Turn your Mac into a fax
machine
Not everyone in the world can

yet cope with email and attachments. So for
these people, who, let’s face it, are barely
one step up from the Amish, Panther comes
with built-in fax software that integrates
with the OS X Address Book – a giant step
up from FaxSTF which used to come
bundled with laptops. Now every time you
print a document, you have the option of
faxing it instead using the ‘Fax’ button. You
can even share your fax line over a network
with other Panther owners using the Print &
Fax System Preference pane. 

Send text messages
with Bluetooth
Got a Bluetooth phone? Then

pair it up with your Mac using the
Bluetooth Assistant and not only will you

be able to sync your contacts and calendar
between the two (subject to iSync
support), you’ll be able to send text
messages to any of your Address Book
contacts without even going near your
phone and its teeny, tiny ‘three letters to a
key’ keyboard. Just click on the word
‘Mobile’ next to your contact’s mobile
number and select ‘SMS message’.

Printing labels with
Address Book 
The Address Book ‘Print’

command is a bit more complicated than
most because it gives you the option to
print out a Filofax, an envelope or a set of
labels. You can use the ‘Paper Size’ pull-
down menu to select not just the standard
A4, but also to pick different sizes of
envelopes and index cards. A ‘Style’ pull-
down menu gives you the option of lists

(so you can print out as much information
about each contact as you like) or mailing
labels – with preset sizes for the ubiquitous
Avery label standard. 

Unlocking accessibility
features
Those with hearing or visual

impairments can still use a Mac thanks to
the Universal Access System Preference
pane – and it can be of help to others. As
well as being able to better set the contrast
of the screen and zoom in, Universal Access
also enables cursor movement using the
keyboard rather than a mouse. And by
enabling assisted devices using the
checkbox at the bottom of the preference
pane, you can also let applications control
and interact with your Mac’s interface.

Network with a PC
Panther’s ability to network
with Windows computers is

now pretty good. As well as being able to
spot Windows PCs and shared printers on a
network almost as easily as it can spot
other Macs, your Mac can also share files
with Windows users using the Sharing
System Preference pane and its ‘Windows

Sharing’ option. If you turn that on, you’ll
also be able to share your printer with
Windows users via ‘Printer Sharing’.

Manage passwords with
Keychain access
Just about every Mac application

now uses your Keychain to store
passwords, enabling you to share
passwords between applications and stop
you from having to remember countless
passwords for different sites and programs.
The Keychain Access utility lets you weed
out old passwords, destroy those that you
typed in incorrectly and keep appearing
whenever you revisit sites, and also remind
yourself of a password when you need to
use another machine. Find it in the
‘Utilities’ folder.

Window minimising
tricks
There are lots of ways to dismiss

a window, but minimising has the coolest
effect. Pressing ‘Apple + M’ in most
applications will do it, as will clicking on the
yellow button in the title bar, selecting
Minimize from the Window menu or double-
clicking the title bar. But the effect is even
cooler if you hold down the shift key while
you do any of the last three: the window
will disappear at a leisurely saunter, leaving
you time to admire the view.
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Fix a broken keychain
The last thing you want to
happen to your keychain is for it

to get damaged. However, OS X has a
hidden way of fixing damage to a
keychain. While Keychain Access is most
often used for editing and viewing
passwords, it’s also got a well-hidden
extra: Keychain First Aid under the
‘Window’ menu. Enter your password and
click on ‘Verify’. You’ll get an analysis of all your passwords to see if any are
damaged. If you use Entourage, you’ll probably find some are missing their ‘port’, but
if there are any other problems, you should repair them. There are other keychain
issues you might encounter, most relating to ease of use, and these are usually
fixable using the ‘Expert’ options.

Power Tips

Panther’s Address Book applications allows you to
easily print Avery labels out to any printer

Amaze your friends with some of Panther’s more
luxuriant excesses by learning how to minimise
windows like this…

Changing your Mac’s icons
Bored with your Mail icon? Want your hard drive to look like Kermit the Frog? Then change the icons using a
downloaded set from the internet

13

1. Download or create a new icon
Unfortunately, you can’t just make a
new icon from the contents of your
clipboard: you have to use an existing
icon. There are plenty on the Web
available for download, and a Photoshop
plug-in for designing your available from
www.iconfactory.com.

2. Get Info on your new icon
In the Finder, highlight the file or folder
that has the icon you want to use. Select
‘Get Info’ from the ‘File’ menu. Then click
on the icon in the Get Info window so
that it gets a blue border. You can now
‘Copy’ the icon to your clipboard by
pressing ‘Apple + C’.

3: Paste on a new icon
Repeat the process with the file or folder
that has the icon you want to change,
but this time ‘Paste’ (Apple + V) instead
of Copy. You should now have a new
icon. In the example above we have
changed the Mail icon into a horse for no
discernable reason other than we can.

Use multiple monitors
Just about every modern Mac
can mirror its display on an

external monitor, but PowerBooks and
PowerMacs can also use a second monitor
as an extension of their built-in or primary
display. Simply plug in the second display
and then use the Displays System
Preference pane to decide where you want
the menu bar and whether you want a
really long monitor or a really deep one. For
Photoshop users and creative professionals,
the benefits are great: palettes on one
screen, image on the other.
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Boot into another OS
with Startup Disk
If your hard drive has more than

one partition, you have more than one hard
drive or your Mac is old enough to run OS 9
outside of OS X, you can install another
operating system and use the Startup Disk
System Preference pane to use it instead of
OS X. So if you have an application that only
runs in OS 9 proper or OS X 10.0 – or even
OS X Server – you can restart your machine
after a swift adjustment to your preferences
and that obsolete program becomes just as
useful as it was ten years ago. 

Partition your hard drive
If you’d like to be able to install
other Operating Systems on your

Mac or even have a backup OS in case OS X
gets damaged irreparably somehow,
partitioning your hard drive is the first step.
This, in effect, creates two or more hard
drives on your desktop that you can format
and install onto however you like. Disk
Utility will allow you to take any disk that
isn’t your Startup Disk (ie not the OS
currently running) and split it up, format it
and resize your partitions however you like.

Speech recognition
technology
In addition to being able to

speak to you in a variety of voices, your
Mac can also understand a basic series of
commands using the ‘Speakable Items’
system. You can enable this using the
Speech System Preference pane and then
tell your Mac to “Close this window” or
“Get my mail”. It will even tell you what
day it is when you ask. 

Monitor your processor
activity
CPU Monitor is a handy way to

see what your Mac is up to at any
moment. In bright, happy colours, it’ll tell
you that your system software isn’t doing
much and that even though you’re only
typing, Word is hogging most of your
Mac’s GHz.

Improving Classic performance
Classic is a necessary evil for old applications. It’s a dog though, so
improving performance is important if you use it often…
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1. Create a disk image
Open Disk Utility and use the ‘New Image
from Folder…’ command to create a
read/write disk image of your OS 9
System Folder. Save it anywhere you like,
but make sure everyone who’s going to
use OS 9 has permission to access it.

2. Mount the image
Next, mount the image by double-clicking
on it. When you open it, you’ll find all of
OS 9 ready and waiting for you.
Unfortunately, OS X can’t spot this yet.

3. Create a new folder
Create a new folder called ‘System
Folder’ and drag everything else into it.
Then you’ll be able to go into the Classic
System Preference pane and select this
folder for Classic.

4. Start Classic
When Classic runs, you’ll need to update
the System Folder as per usual to let it
work with OS X. Using this technique, you
can expect some good Classic speed
improvements since OS X won’t need to
access your disk as much.

Secrets of the Sidebar
New to the Finder in Panther
was an iTunes-esque Sidebar

with shortcuts to all your favourite areas.
Really just an extension to the toolbar at
the top of the window, the Sidebar does
however dynamically add disks as you
mount them (you can change what does
and doesn’t appear by dragging objects to
and from the Sidebar, but also using the
‘Preferences’ command in the ‘Finder’
menu). If the Sidebar is taking up too much
space, you can click on the lozenge in the
top right-hand corner of the window and
make it and the iTunes look disappear. 

Use foreign keyboard
layouts
If you’re not British or you got

your Mac overseas, it’s possible that you’re
used to having your keys in different

places. A US keyboard might be cheaper,
but it doesn’t have a £ sign on it.
Fortunately, even if you’re using a
keyboard that’s foreign to you, you can get
it to work like one you’re used to using the
International System Preference pane. Add
the keyboard you want to the ‘Input Menu’
and then pick it from the menu bar flag
whenever you want to switch.

Encrypt files with
FileVault
If your computer has been

stolen, the last thing you want to happen
is for the thief to take important
information from your files. A password
will secure your Mac against the less
astute thieves, but those who can mount
your hard drive using another computer
stand a better chance. FileVault, enabled
using the Security System Preference pane,
will encrypt all the data in your home
directory, so even if they get as far as
reading your drive, they’ll never be able to
look at your data without the password. Be
careful though – forget this password and
your files are gone forever.

File-sharing
Emailing files around is certainly
handy, but sometimes you

want to send something that’s too big for
an email inbox or you don’t have Internet
access. Using a simple network – AirPort or
otherwise – and by turning on ‘Personal
File Sharing’ in the Sharing System
Preference pane, anything in your ‘Public’
folder is available for download by others.
And if they have an account on your Mac,
they can access all their own files at the
same time.

You can customise the way the Finder’s new
Sidebar behaves by clicking on the ‘Finder’ menu
and tinkering in the ‘Preferences’ dialog box
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Advanced printing
If you have a troublesome
printer on your network,

such as ones that use HP JetDirect, or
if you want to do something nifty
like print to an Internet printer, you’ll
need to bring up Printer Setup
Utility’s advanced options. When
clicking on the ‘Add’ button in the
toolbar, hold down the alt/option
key and at the bottom of the list of
printer options on the next dialog
box, along with ‘USB’ and
‘Rendezvous’, will be ‘Advanced’.
Select that and you’ll find a list of
extra printer types you can use.

Power Tips

When you want to partition your hard drive – just
use Panther’s free Disk Utility program
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Monitoring system
resources
Wondering why your Mac is

suddenly so slow? Maybe it’s a rogue
program doing something odd. Or perhaps
someone has logged into your computer
over a network and is using it to calculate
the trillionth decimal place of Pi. Use
Activity Monitor in your Utilities folder to
find out what – or who – is hogging your
CPU. It will also tell you which applications
are taking up the most memory.

Hack your Mac with
Terminal
Developers often find it takes

more time to remove a feature they were
playing with than it’s actually worth
spending. So, they leave it in – albeit
without necessarily any way for you to use
it. Apple is the same, but using the
Terminal, you can enable some of those
features. “defaults write com.apple.dock
showhidden -bool true” will make hidden
applications transparent in the dock;
“defaults write com.apple.dock wvous-
floater -bool true” will create a blue
floating blob that you can click on to make
Exposé activate; and “defaults write
com.apple.Finder AppleShowAllFiles ‘1’”
will reveal all the invisible files on your
disks that the Finder hides from you. You’ll

have to log out and log back in again to
see these working properly. Changing the
‘1’ or ‘true’ to ‘0’ and ‘false’ in these will
set things back to normal again.

Seeing information
about your Mac 
There’s a whole lot of technical

stuff about your Mac that you probably
don’t know, like its serial number, what
your Ethernet card’s MAC address is and
exactly which versions of all your software
you have. The System Profiler utility has all
this and more, so if you want to know if
you should bother with that monster

updater, or what information you should
plug into your unfriendly new router to
allow your Mac to network properly,
System Profiler is worth a call.

Pick the right
workgroup
If you do lots of Windows

networking, you might want to set a
particular Workgroup as your default, rather
than “WORKGROUP”. Open up the Directory
Access app in the ‘Utilities’ folder and, after
authenticating, double-click on SMB. You’ll
then be able to enter your new workgroup
– and for the really advanced, put in your
WINS server information.

The Secret Safari menu
Safari has a secret ‘Debug’ menu
that you can enable; with it, you

can get Safari to pretend to be another
Web browser, import bookmarks from other
browsers or open its Web page in other
browsers you might have. Quit Safari first,
then open Terminal and type the following
(be careful about the case): “defaults write
com.apple.safari IncludeDebugMenu 1”.
Then restart Safari. If you want to get rid of
the menu, go through the same process but
change the “1” to “0” in the Terminal
command. 

Get London traffic news
from Sherlock
While Sherlock is mostly a tool

for Americans, enterprising developers have
created plug-ins that can actually make it
useful to those of us in the UK. Barney’s
Mac Software
(http://homepage.ntlworld.com/b.hilken/
pages/Software.html) has a plug-in that
allows you to compare prices on videos,
DVDs, music, electronics, books and games
without having to search all the UK
shopping sites yourself, while London Jam

Cams (www.versiontracker.com/
dyn/moreinfo/macosx/18816) gives you
access to all the traffic cameras in London –
see where all the bottlenecks are and if
you’re going to be late for work.

Panther’s hidden
FTP features
FTP may not be pretty, but it is

often the quickest way to transfer files,
particularly over the Internet. Panther
includes its own FTP server, activated using
the ‘FTP Access’ checkbox in the Sharing
System Preference pane, so you can let
people upload and download files from
your ‘Public’ folder. But it also has an FTP
client so you can download files from other
people’s FTP servers. Just ‘Connect to
Server…’ from the Finder’s ‘Go’ menu and
type in the FTP address and you’ll be able
to copy files over as if it was a hard drive.
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Find out which application or person has nicked all your
processing grunt or memory usage with the Activity Monitor

Top Panther 
keyboard shortcuts
The mouse is nice but it’s not as fast as
a keyboard. If you really want to save
time, master the Mac and access some
hidden features, you need to learn
these top 20 keyboard shortcuts.

Apple-W: Close the window

Apple-Shift-W: Close all windows

Apple-M: Minimise the window

Apple-S: Save

Apple-P: Print

Apple-O: Open

Apple-Alt-D: Turn dock on or off

Apple-H: Hide the application

Apple-Alt-H: Hide other applications

Apple-Space: Switch between
languages or keyboards

Apple-Tab: Switch between running
applications

Apple-Shift-Tab: Switch between
running applications in reverse order

Apple-Shift-3: Take screenshot

Apple-Shift-4: Capture part of screen
using crosshairs

Apple-Alt-Esc: Pick an application to
force quit.

In the Finder
Apple-Delete: Move selection to the
trash

Apple-Shift-Delete: Empty trash

Apple-›: Open parent folder

In any dialogue box
Apple-.: Cancel

Return/Enter: Accept the default
(highlighted) button

PDF Services
Often you’ll want to do more than just create a PDF using Panther’s built-
in PDF generator. You might want to email it to someone, open it in a

program, automatically send it to a particular folder or run an entire AppleScript of
things. Panther makes this easy. Create a folder in your Library folder called ‘PDF
Services’. As soon as you do this, the ‘Save as PDF…’ button in print dialogues will be
replaced with a PDF icon with pull-down options. You can now create aliases to
applications or folders in
the PDF Services folder
and they will appear in
the pull-down options
as places to send your
new PDF. 

Power Tips
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Add a menu full of
hidden utilities
Apple provides a great big pile

of useful utilities with OS X that most
people don’t know about. They can print
the contents of Finder windows, replace
text in file names and even give you stock
quotes. To reveal them, go to the
‘AppleScript’ folder in your Applications
folder and run the ‘Install Script Menu’
item. A scroll should appear in your menu
bar with a list of useful new utilities. And
the great thing is you can add your own.

Password protected
screensavers
You might not always be able to

stand guard over your Mac, particularly at
work, so the data thief or the practical joker
can often have a window of opportunity to
fiddle around while you’re gone. But using
the Security System Preference pane, you
can set your Mac so that if you go away for
a while – long enough for the screensaver
to start – any snoop that tries to play
around with your system will need to enter
a password to get in. 

Using special characters
Always trying to remember
what key strokes to use to get

foreign characters such as é or symbols
such as ©? The character palette has all
these and more available a click away. The
quickest way to do summon up the palette
is to go to the Finder and then pick ‘Special
characters…’ from the ‘Edit’ menu. The
palette floats above your other windows so
you’ll always have access to it.

Stay organised with
Labels
Back from the OS 9 graveyard,

Labels let you colour-code your files and
folders. To access them, you can use the
‘Action’ cog in the top of your Finder
windows or by pressing the Control key
while you click to select. Now, what
meaning you attach to the colour yellow is
up to you, but you can change the meaning

displayed using the ‘Preferences’ command
in the ‘Finder’ menu. Then you’ll know what
colour to give an item through the handy
tool tips shown below.

Create a root account
Some bits of Unix software and
some Terminal hacks (for

particularly stubborn file deletion, for
instance) require that you have a ‘root’
account. This is even more powerful than an
administrator account and can do practically
anything to the system. To enable it, open
NetInfo Manager from the ‘Utilities’ folder
and select ‘Enable Root User’ from the
‘Security’ menu. Don’t do this unless you
need to though – and always pick a
different password from your own.

Connect to databases
If you want to access databases
over a network, then the ODBC

Administrator is for you. It allows you to set
up connections between any program –
such as FileMaker, Word or Excel – that
understands the open database connectivity
standard (ODBC) and any database that
supports ODBC. The other detail is you’ll
need to find an OS X ODBC driver for the
database you’re trying to connect to. If you
can muster all of them together, then you’ll
have access to your database data in any
program that needs it.

Turn documents
into PDFs
If you can print it with Panther,

you can also make a PDF from it. No longer
the realm of expensive software like
Acrobat, PDF creation means that you can

send documents that look just like your
originals to anyone and they’ll be able to
read them in any number of programs on
any number of platforms (even some
mobile phones), even if they don’t have
the same software as you or the same
fonts. Just pick the print settings you want.
click on the ‘Save as PDF…’ button at the
bottom of the print dialogue and save it.

Host Web sites on
your Mac
Every copy of OS X has a built in

Web server based on Apache, the most
popular and powerful (and complicated)
Web server in the world. Apple has made it
almost ridiculously easy to run it as well:
just check the ‘Personal Web Sharing’ box in
the Sharing System Preference pane and all

the users on your Mac will have their own
Web sites running out of their Sites folders.
There’ll even be one for the whole machine
tucked away in the Library folder. Let the
whole world know about you and your Mac. 

Keep your updates
Software Update keeps your Mac
up to date, but if you’ve more

than one machine, having to download tens
of megabytes of updates for each one can
take a long time and a lot of bandwidth.
Luckily, there is an option in Software
Update to keep any updater you download
so that you can copy it across a network to
other machines (or keep for a reinstall). Just
select the packages you want to keep then
go to the ‘Update’ menu and pick ‘Install
and Keep Package’.

Move your home directory
Your home directory is in the Users folder of your Startup Disk, but you
can get speed improvements by moving it to another disk altogether…
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Copy over your home directory
Make sure you’ve set up another
administrator account – just in case.
When you’ve done that, copy your home
directory to its intended new location.
Then open up a Terminal window and
drag the copy onto it: that will give you
its Unix path.

Find your NetInfo account settings
NetInfo is the database that stores,
among other things, details about all
your user account’s settings. NetInfo
Manager is your way to alter these
settings. After authenticating, find the
‘Users’ entry and then look for the
account you want to change.

Change the path
When you highlight the account, the
configuration information will appear. Look
for the ‘Home’ entry and double-click on it
to change it. You’ll need to put in the Unix
path name you got in step 1. Save the
changes using ‘Save’ on the ‘Domain’
menu, log out and back in. Job done.

Extra Calculator functions
Apple developed a set of extra
capabilities for Calculator that it never

enabled, including graphing. Enable them by
highlighting the Calculator icon and selecting ’Get
Info’ from the Finder’s ‘File’ menu. Open up ‘Plug-
ins’ section and click on the ‘Add’ button. You can
now navigate through your disk to locate the
Calculator application, but keep on going. Highlight
Calculator, then the ‘Contents’ folder inside, then
the ‘Resources’ folder inside that. Lurking among
the other folders will be Graphing-2D.calcview,
Hexadecimal.calcview and
ExpressionSheet.calcview. Highlight the one(s) you
want to add and click the Choose button. Now
when you next run Calculator, you’ll get up to
three new options under the View menu.

Power Tips

Add extra features to your Mac by enabling
AppleScript – the Mac’s very own scripting language
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